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LEGAL INFORMATION

Product Warranty

Educational tools and test instruments manufactured or distributed by IngMar Medical, LLC come with
a limited warranty, covering materials and workmanship, for a period of one year from the date of
shipment, except for products with stated warranties other than one year. Software, fuses and
batteries are excluded from this warranty. System components such as computers are supplied with
the factory warranty of the original manufacturer. IngMar Medical, LLC reserves the right to perform
warranty service(s) at its factory, at an authorized repair center, or at the customer's installation.
IngMar Medical, LLC's obligations under this warranty are limited to repairs, or at IngMar Medical,
LLC's option, replacement of any defective parts of the purchased equipment, without charge, if said
defects occur during normal service.

Claims for damages during shipment must be filed promptly with the transportation company. All
correspondence concerning the equipment must specify both the model name and number, and the
serial number as it appears on the equipment.

Improper use, mishandling, tampering with, or operation of the equipment without following specific
operating instructions will void this warranty and release IngMar Medical, LLC from any further
warranty obligations.

The above is the sole warranty provided by IngMar Medical, LLC. No other warranty, expressed or
implied, is intended. Representatives of IngMar Medical, LLC are not authorized to modify the terms of
this warranty.

For factory repair service, call:

Toll free: 1-800-583-9910
International: +1(412) 441-8228
Facsimile: +1 (412) 441-8404

or contact us via e-mail at:  support@ingmarmed.com
Our shipping address:

IngMar Medical, LLC.
5940 Baum Blvd
Pittsburgh, PA 15206
USA

Please note that a valid service return order (SRO) number is always required before sending in any
products for repair, calibrations, or updates.
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Limitation of Liability

IngMar Medical LLC.'s liability, whether arising out of or related to manufacture and sale of the goods,
their installation, demonstration, sales representation, use, performance, or otherwise, including any
liability based upon above defined product warranty, is subject to and limited to the exclusive terms
and conditions as set forth, whether based upon breach of warranty or any other cause of action
whatsoever, regardless of any fault attributable to IngMar Medical, LLC, and regardless of the form of
action (including, without limitation, breach of warranty, negligence, strict liability, or otherwise).

THE STATED EXPRESSED WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR
IMPLIED, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY
PARTICULAR PURPOSE, OR NONINFRINGEMENT.

IngMar Medical, LLC shall not be liable for, nor shall buyer be entitled to recover, any special incidental
or consequential damages or for any liability incurred by buyer to any third party in any way arising out
of or relating to the goods.

Trademarks

SimMan®, Nursing Anne™ and SimBaby™ are registered trademarks of Laerdal Medical Corporation.
Windows® and Visual Studio® are registered trademarks of Microsoft Corporation.

All other trademarks or registered trademarks are property of their respective owners.

Copyright
© 2022, IngMar Medical, LLC.

No parts of this document may be reproduced, stored in a retrieval system, translated, transcribed, or
transmitted, in any form, or by any means, without identifying its authorship as IngMar Medical, LLC.

IngMar Medical, LLC is not responsible for translations of its proprietary manual



Software License Agreements
Acknowledgement of this license agreement is also part of the host software installation process:

LICENSE AGREEMENT

BY INSTALLING AND USING THE SOFTWARE, YOU INDICATE ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS.

ENTIRE AGREEMENT

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND UNDERSTAND THIS AGREEMENT (THE “AGREEMENT")
IS THE FINAL, COMPLETE AND EXCLUSIVE STATEMENT OF THE ENTIRE AGREEMENT BETWEEN INGMAR MEDICAL, LLC
(“INGMAR") AND YOU. THIS AGREEMENT SUPERSEDES ANY PRIOR AND CONTEMPORANEOUS PROPOSALS, PURCHASE
ORDERS, ADVERTISEMENTS, AND ALL OTHER COMMUNICATIONS IN RELATION TO THE SUBJECT MATTER OF THIS
AGREEMENT, WHETHER ORAL OR WRITTEN. NO TERMS OR CONDITIONS, OTHER THAN THOSE CONTAINED IN THIS
AGREEMENT, AND NO OTHER UNDERSTANDING OR AGREEMENT WHICH IN ANY WAY MODIFIES THESE TERMS AND
CONDITIONS, SHALL BE BINDING UPON INGMAR UNLESS MADE BY A WRITTEN AGREEMENT, EXECUTED BY DULY
AUTHORIZED REPRESENTATIVES OF BOTH INGMAR AND YOU.

SOFTWARE AND DOCUMENTATION LICENSE

1. IngMar Medical, LLC hereby grants you a non-exclusive, non-transferable license to use the enclosed computer
instrumentation software (the “Software”) and any associated printed documentation (the “Documentation®), subject to
the limitations set forth in this Agreement (the “License”). All right, title and interest to the Software and the
Documentation are, and shall remain, in IngMar and/or its licensor. You have no right of access to the source code of the
host system software (the software running on your PC).

2. You may not alter, assign, decompile, disassemble, distribute, lease, modify, reverse engineer, sublicense, transfer or
translate in any way the Software or Documentation except as provided in the following clauses:

i) You may permanently and simultaneously transfer all of the Software, Documentation and the License if: a) you deliver to
the transferee the Software and Documentation (including updates and upgrades) supplied by this Agreement; b) notify
IngMar in writing of such transfer; and c) destroy any archival/backup copy. A transfer immediately terminates the License.
You agree that the transferee must expressly accept all terms and conditions of this Agreement.

3. YOU MAY NOT COPY THE SOFTWARE OR DOCUMENTATION; provided, however, that you may make one (1) copy of the
Software for archival/backup purposes.

4. If either the Software or Documentation is used in any way not expressly and specifically permitted by this License, then
the License shall immediately terminate. Upon the termination of the License, you shall thereafter make no further use of
the Software or Documentation, and you shall return to IngMar all licensed materials, postage prepaid.

5. THE SOFTWARE IS NOT INTENDED TO BE USED FOR ACTUAL ANALYSIS AND DIAGNOSIS OF MEDICAL CONDITIONS OF
HUMANS OR ANIMALS.

WARRANTIES

1. LIMITED WARRANTY ON MEDIA. For a period of thirty (30) days following the date of delivery to you as the original
licensee, if evidenced by your receipt as such, (the “Warranty Period”) IngMar Medical, LLC warrants the flash memory
device on which the Software is embodied (if Software was delivered to you on a USB flash drive) to be free from defects in
materials and workmanship under normal use. The warranty is personal to you, and no warranty is made to your
transferees. THE FOREGOING WARRANTIES ARE THE SOLE WARRANTIES ON THE MEDIA AND ARE IN LIEU OF ALL
WARRANTIES OF ANY KIND, SUCH AS WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.

2. NO WARRANTY ON SOFTWARE OR DOCUMENTATION. INGMAR LICENSES THE SOFTWARE AND DOCUMENTATION SOLELY
ON AN “AS IS BASIS WITHOUT WARRANTIES OF ANY KIND, SUCH AS WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
ANY PARTICULAR PURPOSE. THE ENTIRE RISK OF QUALITY AND PERFORMANCE IS WITH YOU. IF EITHER THE SOFTWARE,
DOCUMENTATION OR BOTH PROVE TO BE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL SERVICING, CORRECTION OR
REPAIR.

REMEDY FOR DEFECTIVE MEDIA
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Your sole and exclusive remedy in the event of a defect in a warranted item is expressly limited to replacement of the
defective media. To receive a replacement USB flash drive, you must send the defective flash device, with proof of
purchase, to IngMar at the address indicated below, postage pre-paid and postmarked within the Warranty Period.

IN NO EVENT SHALL INGMAR BE LIABLE FOR ANY OTHER OBLIGATIONS OR LIABILITIES INCLUDING, WITHOUT LIMITATION,
LIABILITY FOR DAMAGES (WHETHER GENERAL OR SPECIAL, DIRECT OR INDIRECT, CONSEQUENTIAL, INCIDENTAL,
EXEMPLARY), OR FOR ANY CLAIM FOR THE LOSS OF PROFITS, BUSINESS OR INFORMATION, OR DAMAGE TO GOOD WILL
EVEN IF INGMAR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY EVENT, INGMAR'S MAXIMUM
LIABILITY SHALL BE LIMITED TO THE AMOUNT OF THE PURCHASE PRICE.

U.S. GOVERNMENT RESTRICTED RIGHTS LEGEND

The Software and Documentation have been developed exclusively at private expense and are provided with RESTRICTED
RIGHTS. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) of the
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c) (1) and (2) of the
Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. IngMar Medical, LLC is the Contractor,
and is located at 5940 Baum Blvd, Pittsburgh, PA 15206.

EXPORT RESTRICTIONS
The program or underlying information or technology may not be installed or otherwise exported or re-exported where
prohibited by law.

MISCELLANEOUS

This Agreement shall be considered severable, and if for any reason any term or condition is determined to be invalid,
illegal or unenforceable under current or future law, such invalidity shall not impair the operation of, or otherwise effect,
the valid terms and conditions of this Agreement, so long as the intent of this Agreement is maintained.

This Agreement shall be governed by, construed and enforced in accordance with the laws of the Commonwealth of
Pennsylvania, with the exception of its conflict of law provisions. The parties consent to the personal jurisdiction of the
Commonwealth of Pennsylvania and agree that any legal proceedings arising out of this Agreement shall be conducted
solely in such Commonwealth.

No action, regardless of form, arising out of this Agreement may be brought by either party more than one (1) year after a
claim has accrued.
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1 SAFETY CONSIDERATIONS

1.1 Operator Safety

For correct and effective use of the product it is mandatory to read and to observe all INSTRUCTIONS,
WARNINGS, and CAUTION statements in this manual. If the product is not used as instructed, the
safety protection provided may be impaired.

/N T

Indicates a potentially harmful condition that can lead to personal injury.

A CAUTION!

Indicates a condition that may lead to equipment damage or malfunction

B NortEe

Indicates points of interest or emphasis for more efficient or convenient operation.
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1.2 Intended Use

The ASL 5000™ Lung Solution enhances the Laerdal SimMan®,SimMan® ALS, SimBaby™, and Nursing
Anne™ products by merging the best-in-class ASL 5000™ Breathing Simulator into the Laerdal LLEAP
simulation environment. This integration improves the true-to-life experience with realistic airway
response to ventilators, anesthesia machines, CPAP, etc. A hardware component, which can be a
permanent installation, allows the user to switch between the SimMan® and SimMan® ALS,
configurations and the enhanced ASL 5000™ configuration. The Nursing Anne™ hardware component
does not provide the same switching capability. The SimBaby™ hardware component is external to the
manikin. A software component provides a series of windows which are added directly to the LLEAP
environment. These windows give the user direct control of the ASL 5000™ as well as the ability to use
LLEAP’s existing Airway & Breathing window controls.

} 3 NortEe

In this manual the name SimMan® applies to SimMan® 3G, SimMan® Essential,
SimMan®Essential Bleeding, SimMan® Trauma and SimMan® ALS unless otherwise stated.

The software provided for the Lung Solution is designed for LLEAP version 6.3 or greater for the
SimMan® manikins and 6.7 or greater for SimMan® ALS, SimBaby™ and Nursing Anne™
manikins. Please contact IngMar Medical, LLC (sales@ingmarmed.com) for details on future
integration into additional Laerdal manikin simulators. LLEAP software and firmware are
directly accessible from the Laerdal website www.laerdal.com. Please verify the software and
firmware are up to date before using the Lung Solution.

/N

The use of supplemental oxygen is prohibited with the SimMan®, SimBaby™ and Nursing
Anne™ products. The ASL 5000™ Breathing Simulator allows use of Oxygen-rich gas with
these manikins disconnected but through the Local Connection option (ASL 5000™ as a stand-
alone simulator connected directly to a ventilator, CPAP, or anesthesia machine).

10


mailto:info@ingmarmed.com)
http://www.laerdal.com/

2 AN INTRODUCTION TO THE ASL 5000™ LUNG SOLUTION

The ASL 5000™ Lung Solution creates a direct integration between the ASL 5000™ Breathing Simulator
and Laerdal SimMan®, SimBaby™ and Nursing Anne™ manikin simulators. Once installed, the user can
experience a high-fidelity respiratory system added to the many features already available with these
manikin simulators.

This includes the ability to ventilate the patient with a wide range of lung resistance, compliance, and

spontaneous breathing parameters. The ASL 5000™ can hold large amounts of PEEP (<20 cmH20) and
is able to exert and receive large volumes (up to 2.5L of tidal volume).

2.1 Lung Adapter for the SimMan®

Once installed, the Lung Adapter can be left in place as a permanent fixture. The system can be easily
switched between the ASL 5000™ lung mode (bypassing the internal SimMan® lung bags) and the
standard SimMan® mode.

Figure 2-1 — Installed Lung Adapter

11
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2.2 Lung Adapter for the SimBaby™

As of LLEAP software version 6.7, the SimBaby™ includes internal components to detect if an ASL
5000™ Breathing Simulator is being used. The Lung Adapter for this manikin requires no internal
reconfiguration as compared to the SimMan® manikin family. A 15mm side port next to the RJ45
Ethernet connector provides the link between the SimBaby™ and the ASL 5000™. When the ASL
5000™ is not required for simulations, a plug is included directing the flow of air into the baby lungs.

g 4
Figure 2-2 - SimBaby™ and Plug Location

2.3 Lung Adapter for Nursing Anne™

With the release of LLEAP software version 6.7, Nursing Anne™ can now be integrated with the ASL
5000™ Breathing Simulator. See the Nursing Anne™ Quick Setup Guide for more information on the
conversion.

s o
Figure 2-3 — Nursing Anne™ with ASL 5000™ conversion

12



2.4 Lung Solution Windows

The Lung Solution software enhances realism in the LLEAP environment by providing six (6) additional
windows that work with the high-fidelity lung simulator. These windows are explained below.

ASL Session Control — This window controls the connection to the ASL 5000™ and the volume/gas
conditions (e.g. ventilators working in BTPS mode). This window also displays connection status and
controls the simulation with Play, Pause, and Stop functionality.

2 .
. /- ASL Status: Unconnected
Conflgure > II . Co(r:nect Device: Standalone

Figure 2-4 - ASL Session Control
ASL Quick Choice Menu — This window provides predefined patient types and disease states. The
window gives the user easy access to various lung / airway diseases with the ability to adjust the
severity of those diseases. Simply click on a disease, click apply and adjust the severity. Custom or
user-defined disease states are also accessible from this window via the Custom Models toggle switch.
The simulated patient can also mimic a passive (or paralyzed) patient via the Apnea toggle switch.

AEL Quick Chobce Meru ASL Lung Model Cordred ASL Emeath Effort Cortrol " ke B | MM ) Medet ComIM | A ISR IONE Cadivn

-é' INGMAR MEDICAL ‘é’ INGMAR MEDICAL

Patient Type: Lusng Model: Custom Madels | Patient Type: Lung Model: Custom Models
Asthma / BPD
Apnea |
Apnea
Select the severity of the disease state:
Select the severity of the disease state:
L ee—
=l m | .

| M Hzgerae severe ad PR

Figure 2-5 - ASL Quick Choice Menu

13
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ASL Lung Model Control — This window controls the airway resistance and lung compliance of the ASL
5000™. The user can select a simplified lung model consisting of a single resistance and compliance.
Switching to the Advanced view, the user can create a more complex dual lung model, which can
include (but is not limited to) variations in inspiratory versus expiratory resistance.

&5L Quick Chedce Menu | ASLLung Model Contrel | ASL Breath Effart Contrel

Breaths Per Change: n Advanced

Resistance (emH20/L/s) Compliance (mL/cmH20)

150

Figure 2-6 - ASL Lung Model Control

ASL Breath Effort Control —This window has basic settings for Breath Rate and Muscle Pressure
(patient effort required to take a breath), the driving force for volume in the lungs. Switch to the
Advanced view and create a complex muscle pressure profile for an accurate representation of
spontaneous breathing.

ASL Quack Choice Menu | ASL Lung Model Control | ASL Breatn Eftort Control

Breaths Per Change: [l Advanced
Muscle Pressure [cmH20] Rate [bpm]
80 100 80 100
60 0 60 0
40 20 40 20

Figure 2-7 - ASL Breath Effort Control

14



B’ Norte

The Lung Model and the Breath Effort Control windows include a feature called Breaths Per
Change (BpC). This feature brings more realism to changes in the model by transitioning from
one state to the next over the selected number of breaths. The user can control the
progression of a change based on the selection. In the figure below, a change will transition
over 4 breaths.

Breaths Per Change: n

Figure 2-8 Breaths Per Change

ASL Monitor — This window provides feedback from the point of view of the lung. The window
includes waveforms for lung pressure, flow, and volume. Also displayed are relevant breath
parameters including PEEP, PIP and Tidal Volume.

Airmay Presurs [
Muscle Pressure ~ | Y

z 10

Flow [L
s
-
(%) ]

Tidal Voksme jl)

Tidal Voume E 200 MV (1 fwin]
| 5.13

Figure 2-9 - ASL Monitor
ASL Equation of Motion — This window provides a graphical representation of the equation of motion
of air in the system (as a teaching tool). At any time during the simulation, view the most recent
breath in better detail by clicking the View Last Breath toggle switch.

ASL Monitor ASL Equation of Motion Theme Contral CPR CPR History

View Lastsreatn (|
Pmus + Paw = + Flow - R

18
g
x 14
[
Z10
£ g
E
£

-2

o 5 10 15
Time [s]

12
: s
2
o4
N
2o
[}
= _ 1

-4

0 5 10 15

Time [s]

Figure 2-10 - ASL Equation of Motion
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2.5 Components

The ASL 5000™ Lung Solution has three major components: Lung Adapter hardware (as applicable to
the manikin), software installer, and ASL 5000™ Breathing Simulator. The Lung Adapter creates a
bypass from the internal manikin lungs to the ASL 5000™. For the SimMan® family of compatible
manikins, the Lung Adapter includes a selector-switch to easily toggle between the SimMan® lungs and
the ASL 5000™. The Lung Adapter is designed to provide a user-friendly installation and does not
require removal once it is installed. For the SimBaby™ manikin, the internal bypass is automatically
controlled by the LLEAP and ASL Plugin software. Therefore, only the SimBaby™ Lung Adapter external
tubing is required. For Nursing Anne™, the conversion kit does not include a selector switch.

Because the software is designed as an add-on to the LLEAP environment, the user can access any of
the ASL 5000™ windows via the file menu, “View” dropdown.

n Healthy patient - Virtual SimMan 3G - Manual Mode - LLEAP
File Tools  SimStore  Help

ASL Scenario Language L] ASL Breath Effort Control Pati

Show Disabled Messages
- Full Screen F11

Windows 3

Airway & Breathing
Cardiac
Circulation & Fluids

Pa Arrange Windows F3

Save Layout as...

Load Layout 3 Comments

Connections Status
CPR

CPR History
Events

Eyes

Learner Patient Monitor Buttons

[c[efelefe[efee[o o e e]e] [e]&fefe]s&]<]™

Local PC Status
Ongoing care

Patient Monitor

Prediction
Session Control
Session Log

Simulator

Sounds
Ap Status Bar

Theme Control

Trends

ASL Monitor

ASL Breath Effort Control
ASL Equation of Motion

ASL Lung Model Control
ASL Quick Choice Menu

ASL Session Control

Figure 2-11 — ASL 5000™ Window Access

SEBEEBEEBEERA

Each of the ASL windows allows for direct control of the ASL 5000™. This includes changing a
predefined disease state / lung model or directly controlling lung mechanics (resistance, compliance,
etc.). At any time during a simulation, the user can invoke real-time changes to the patient and
observe a direct reaction from an external device (e.g. ventilator, CPAP, etc.).

By accessing the View -> Load Layout menu dropdown, users can load the “IngMarDefault” layout for
the SimMan® family, the SimBaby™ and Nursing Anne™. This layout organizes the LLEAP and ASL
5000™ windows into a user-friendly view.
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I] PALISE - Healthy patient - Virtual SimMan 3G - Manual Mode - LLEAP
File | View | Tools SimStore  Help

ASL Scenario Language k3l | ASL Breath Effort Control

Show Disabled Messages

Full Screen F11 I
tindevs '/AR MEDICAL
Arrange Windows F3 -

Save Layout as...

| Load Layout
FAauernt rype.

| I Reset to Default Layout

Figure 2-12 - ASL Default Layout

To improve the simulation experience, IngMar Medical has also created a custom view for the
Respiratory themes provided by LLEAP, called “IngMarUnhealthy”. These include:

e Adult -> Respiration -> Asthma

e Adult -> Respiration -> Morphine Overdose

e Adult -> Respiration -> Pneumothorax

I] PALISE - Asthrna - Virtual SimMan 3G - Manual Mode - LLEAP
File | Wiew | Tools  SimStore  Help

. Scenario Language r
Show Disabled Messages

Full Screen F11 [ 4] >,
Windows r f:‘/ ,
5 Arrange Windows = athing Physician Medicat

Save Layout as...

Load Layout | IngMarlUnhealthy

Back to Last Loaded Layout
Reset to Default Layout

Wash hands

Figure 2-13 - ASL Unhealthy Layout
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3 ASL5000™ LUNG SOLUTION OPERATION FOR SIMMAN® FAMILY

3.1 Switching Between SimMan® (SIM) and ASL 5000™ (ASL)

3.1.1 Selector Plate

Open the SimMan® and locate the selector plate.

Figure 3-1 - Selector Plate

1. With the thumb and a finger, hold the bottom of the selector using the crescent-shape
cutouts.

2. Pull up on the knob to separate the top and bottom of the Selector, allowing the top of the
Selector to rotate.

3. Turn the selector to ASL or SIM mode.

4. Push the top and bottom of the Selector together to make a secure connection.

A CAUTION!

Do not try to unscrew the knob from the Selector. The top plate will rotate once it is pulled
away from the bottom plate.

18



3.1.2 ASL 5000™ Operation (Switching from SIM to ASL)

e Setthe selector to ASL. The indicator hole next to the ASL label should be green
e Remove the external orange / red plug

e Insert the 90° elbow, from the external tubing, into the ASL port

e Insert other end of the external tubing into the ASL 5000™ simulator

e (Close the SimMan®

Figure 3-2 - ASL Option

3.1.3 ASL 5000™ Operation (Switching from ASL to SIM)

e Set the selector to SIM. The indicator next to the SIM label should be green
e If applicable, remove the 90° elbow and external tubing from the SimMan®
e Insert the external orange / red plug

e (Close the SimMan®

Figure 3-3 - SIM Operation

7707 "2 ‘[e2IPAIN JeNBU| @ ‘ET "AdY ‘uolin|os BunT ,,0005 1SV 404 [BNUEBIA J3SN 008 TE 08 "ON Hed



Part No. 80 31 800 User Manual for ASL 5000™ Lung Solution, Rev. 13, © IngMar Medical, LLC. 2022

3.2 Preparing the SimMan® for use

Once the software is installed and the manikin has been prepared with the Lung Adapter, the ASL
5000™ Breathing Simulator can be connected to run the enhanced respiratory simulations within the
LLEAP software environment.

3.2.1 Preparing the Simulation Environment

Prior to zipping the side skin of the manikin, plug the 22mm 90° elbow adapter into the external ASL
port and close the SimMan®. If the orange / red plug is not tethered to the Lung Adapter, make sure to
store the plug when the ASL 5000™ is not in use.

Figure 3-4 - External Airway Port

Figure 3-5 - System Setup
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3.2.2 Preparing the Network Configuration

@ NorTtE

It is assumed that for SimMan, LLEAP version 6.3 or later is installed, or for SimMan ALS, LLEAP version
6.7 or later is installed. It is also assumed that the latest ASL 5000™ LLEAP plugin is installed prior to
configuring the connection

Once the SimMan® network is configured, connect the ASL 5000™ and the SimMan® in one of the
configurations as recommended below.

A CAUTION!

Please assure that the order of operations is followed. If the ASL 5000™ is turned on before a
functioning network is connected, the ASL will not obtain an IP address and thus not connect to
LLEAP.

@ NortEe

The SimMan® ALS does not have an internal network router. This manikin has a similar network
configuration to the Nursing Anne and SimBaby simulators. Instructions on preparing the network
configuration for these manikins can be found in Section 4.3 of this guide.

21
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3.2.2.1 Connection Using SimMan® in “AP” Mode (not SimMan®ALS)

1. Connect an Ethernet cable from the LAN port of the SimMan® to the Ethernet port of ASL
5000™

e |0 SimMan

To ASL 5000™

(=)
Ethernet oo

Figure 3-6 - Ethernet Cabling

2. Turn the SimMan® power ON and wait until the system has completed its booting process
3. AFTER the SimMan® is breathing and its eyes are blinking, turn on the ASL 5000™

ASL power switch

(rear of system)

OFF for the system to be ready

Figure 3-7 - ASL Power and Ready States

4. After the red light on the front of the ASL 5000™ is OFF (~30 seconds), start the LLEAP software
5. From the View menu, open the IngMarDefault layout to view the six (6) ASL windows
6. Locate the ASL Session Control tab which will share the window with LLEAP’s Session Control

[0 PAUSE - Heslthy patient - Virtusl SimMan 3G - Manual Mode - LLEAP

File Tools SimStore Help

Scenaric Language 3 Body 50
The ’
I Show Disabled Messages

Full Screen F11

Windows »

Arrange Windows

Save Layout as..

Load Layout

Figure 3-8 - IngMarDefault Layout
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7. Configure the ASL 5000™ connection settings in ASL Session Control window

Click Configure

Configu

9
relLal | N | o

Connect

Unconnected
Standalone

ASL Status:
Device:

ASL 5000 Configuration

Click Connection Settings

Manikin Attached

Shivw Tatal Violume

L )

Done

Click Ethernet

Ethernet

Cancel

Plense select the connection type:

Click Okay

——

8. Click on Device ID:
9. Type the ASL serial number into the Device ID: field
he Static IP button

10. Ignore the IP: field and t
11. Click Done

Figure 3-9 - Configuring Ethernet Connection

Network Address:

Type ASL serial number

Configure Connection (found on rear of ASL)

Static IP

Do Not Use

Cancel

[ Done N

Figure 3-10 - Selecting ASL by Serial Number

Click Done
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12. Complete the connection

ASLSession Control || Sesslon Control

451 Session Control | | Session Contral

ASL Session Contrel || Session Control

SR
Op
Connect

N/

SEEER

&2

Disconnect
—

)

&?

Disconnect

Press Connect to
establish connection

|

ASL Status:
Device:

ASL Status:
Device:

ASL Status:
Device:

Unconnected
1821

Unconnected

Connecting
1821

Connected
1821

Figure 3-11 - Connecting to ASL by Serial Number

Connecting

Connected

13. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization

14. On the “ASL Session Control” or LLEAP “Session Control” windows, click the ® button to start a

simulation




3.2.2.2 Connection Using SimMan® in “Client” Mode (not SimMan®ALS)

1. Connect an Ethernet cable from ASL 5000™ to a numbered port on an external router
OR
2. Connect an Ethernet cable from ASL 5000™ to a network (via wall jack, for example)

To ASL 5000™

Ethernet ¢ / Respi-
o E'gﬁ i i_ Patient

To Router or wall jack

To ASL 5000™

Figure 3-12 - Ethernet Cabling

3. Turn the SimMan® power ON and wait until the system has completed its booting process
4. AFTER the SimMan® is breathing and its eyes are blinking, turn on the ASL 5000™

& ASUso

CATHON Active Servg \Lung

—
—
p—
—

ASL power switch
(rear of system)

Wait for red light to turn
OFF for system ready

Figure 3-13 - ASL Power and Ready State

5. After the red light on the front of the ASL 5000™ is OFF (~30 seconds), open the LLEAP software
6. From the View menu, open the IngMarDefault layout to view the six (6) ASL windows
7. Locate the ASL Session Control tab which will share the window with LLEAP’s Session Control

25
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[0 PAUSE - Healthy patient - Virtual SimMan 36 - Manual Mode - LLEAP
File Tools SimStore  Help

- Scenario Language , Body so
e
Show Disabled Messages Heart:
s are set to normal
Full Screen 2l L Lung:

‘Windows »

Amange Windows

Save Layout as.

Load Layout

m Default Layout

Korotke

1cere || 45, octeved coves |

-¢~ INGMar MEDICAL

Figure 3-14 - IngMarDefault Layout

8. Configure the ASL 5000™ connection Settings in the ASL Session Control window

Click Configure

Conﬁgure >N E 00 ASL Status: Unconnected

Connect Device: Standalone

Click Connection Settings

Connection Settings

Manikin Attached

Shivw Tatal Violume

Daone

AsL

Please select the connection type:

Click Ethernet Ehernet

Click Okay

Figure 3-15 - Configuring Ethernet Connection




9. Click Device ID:

10. Type the ASL serial number into the Device ID: field
11. Ignore the IP: field and the Static IP button

12. Click Done

|
Type ASL serial number
(found on rear of ASL)

Configure Connection

% Device ID 1234

Network Address:

1 Do Not Use
&,

Static IP

Click Done
Done

Figure 3-16 - Selecting ASL by Serial Number

13. Complete the connection Press Connect to

ot seron comrt | SRR establish connection

. ASL Status: Unconnected
Configure Ll Ll | &P Device: Unconnected
Connect ’
451 Session Control 1 Contral
SR
) ) )
- < ASL Status: Connecting
Configure Ll | N | O o - i
Disconnect]  Device: 1821 Connecting
—/
——
20 .
. 4 ASL Status: Connected
Configure Ll [ | 2 e - Connected
Disconnect Device: 1821
|

Figure 3-17 - Connecting to ASL by Serial Number

14. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization

15. On the “ASL Session Control” or LLEAP “Session Control” windows, click the ® button to start a
simulation

27
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3.2.2.3 Connection Using SimMan® in “Client” Mode, when the ASL 5000™ requires a
unique IP address (not SimMan®ALS)

B NoTtEe

In some configurations, the customer may require all devices on their network be given specific IP
addresses. Once the IP address is known, follow the steps below for a successful connection.

1. Connect an Ethernet cable from ASL 5000™ to a numbered port on an external router
OR
2. Connect an Ethernet cable from ASL 5000™ to a network (via wall jack, for example)

To ASL 5000™

Ethernet % USB ‘{ ./ Respi-

Patient

To ASL 5000™

To Router or wall jack

Figure 3-18 - Ethernet Cabling

3. Turn the SimMan® power ON and wait until the system has completed its booting process
4. AFTER the SimMan® is breathing and its eyes are blinking, turn on the ASL 5000™

ASL power switch : ‘ T
rear of system k e =
( ! ! : Q k! AR\ toon
—— Wait for red light to turn
—— OFF for system to be ready
—

Figure 3-19 - ASL Power and Ready State

5. After the red light on the front of the ASL 5000™ is OFF (~30 seconds), open the LLEAP software
6. From the View menu, open the IngMarDefault layout to view the six (6) ASL windows
7. Locate the ASL Session Control tab which will share the window with LLEAP’s Session Control
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[0 PAUSE - Healthy patient - Virtual SimMan 36 - Manual Mode - LLEAP
File Tools SimStore  Help

e Scenario Language » Body so
Show Disabled Messages Heart:
Full Screen 2l LLung:
Windows ’ RLung:
Arrange Windows F3 Sowel:

Save Layout as.

Load Layout IngMarDefault e

Korotke

A4 == ;@ f! l;..l

ASL Session Control | 7= = s

000 ®

Figure 3-20 - IngMarDefault Layout

8. Configure the ASL 5000™ connection settings in the ASL Session Control window

Click Configure

\

Conﬁgure >N E 00 ASL Status: Unconnected

Connect Device: Standalone

ASL 5000 Configuration

Click Connection Settings [ —

Manikin Attached

Shivw Tatal Violume

Daone

AsL

Please select the connection type:

Click Okay

Click Ethernet Ehernet

Figure 3-21 - Configuring Ethernet Connection
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9. Click Network Address:

10. Type the IP address provided by the customer into the Network Address: field

11. Ignore the Device ID: field and the Static IP button

12. Click Done
Type IP address
provided by customer
Configure Connection
Do Not Use
= .
=| Device ID:
, 192.168.168.112) Click Done
|__Done |
Figure 3-22 — Selecting ASL by IP Address
13. Complete the connection Press Connect to
establish connection
)
. 2 ASL Statusy Unconnected
Configure gl LI 'l Device: \ 192.168.168.11] | Unconnected
Connect : PSR
—
. .
22 ASL Statug Connectin
Configure L L | o aty g .
Disconnect] ~ Device:\_ 192.168.168.11) | Connecting
./
- ASL Statug Connected
Configure Ll [l _ o 168 168 Connected

Device: 192.168.168.11

Figure 3-23 — Connecting to ASL by IP Address

14. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization

15. On the “ASL Session Control” or LLEAP “Session Control” windows, click the
simulation

» button to start a




3.2.2.4 Connection Using SimMan® as Virtual Simulator (Local Computer) with a
Physical ASL 5000™ Breathing Simulator (not SimMan®ALS)

B NoTtEe

LLEAP can control the ASL 5000™ while running as a Virtual Simulator. The same requirements hold for
the ASL 5000™ where it must have an IP address provided by any of the methods defined above. The
computer running the LLEAP software MUST be connected to the same network as the ASL 5000™
(same IP subnet)

1. Connect an Ethernet cable from the LAN port of the SimMan® to the Ethernet port of ASL
5000™
OR
2. Connect an Ethernet cable from ASL 5000™ to a numbered port on an external router
OR

w

Connect an Ethernet cable from ASL 5000™ to a network (via wall jack, for example)

4. If using the SimMan® as the network in AP mode (using the Virtual Simulator via LLEAP), turn
the SimMan® power ON and wait until the system has completed its booting process.

5. AFTER the SimMan® is breathing and its eyes are blinking, turn on the ASL 5000™

After the red light on the front of the ASL 5000™ is OFF (~30 seconds), open the LLEAP software

7. When the LLEAP Select Simulator window opens, in the Virtual Simulator window, select Local

computer

o

LLEAP

Select Simulator

Network Status\ Vi~ simulator
LAN: connected - I
Hosted: active Mot started yet

Select Local computer

Patient Simulator

SIMMANS3-A4270UC SimMan Essen... m
Running in start state -

Standardized patient
Mot started yet

Task trainer
Mot started yet

AL

Advanced options

Figure 3-24 - LLEAP Select Simulator Window
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8. Select one of the compatible manikin simulators

Select Virtual Simulator

SimMan 3G SimMan Essential

SimMan Essential Bleeding ::& Nursing Anne Simulator

SimJunior SimBaby

ALS Simulator SimMan

SimMan ALS SimMan 3G Mystic

SimMan 3G Trauma SimMom

Figure 3-25 - LLEAP Available Manikins

9. From the View menu, open the IngMarDefault layout to view the six (6) ASL windows
10. Locate the ASL Session Control tab which will share the window with LLEAP’s Session Control

[0 PAUSE - Healthy patient - Virtual SimMan 3G - Manual Mode - LLEAP
File Tools SimStore Help

Scenario Language » Body so

The!
I Show Disabled Messages

s are set to normal

Full Sereen Fi1
Windows »
Arrange Windows

Save Layout as..

Load Layout

S R

a2 S —
M| e
Dl O Odan we
IR UL

=

000

Figure 3-26 - IngMarDefault Layout

32



11. Configure the ASL 5000™ connection Settings in the ASL Session Control window in any of the
configurations from the options above.

12. Make sure the “Manikin Attached” toggle is in the OFF position (not green) as shown in the
image below

O o e

ASL 5000 Configuration

Volume Conversion
Settings

Connection Settings

Manikin Attached

Show Total Volume

|
y
-\-\I
vy

Figure 3-27 — Manikin Compensation Toggle

13. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization

14. On the “ASL Session Control” or LLEAP “Session Control” windows, click the ® button to start a
simulation
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3.2.3 Returning to the Standard SimMan® Configuration
The standard SimMan® configuration for simulations not requiring the enhanced respiratory option
requires the following steps.

e Unzip the side skin of the manikin and remove the 22mm elbow adapter

e Switch the Selector to SIM mode

e Insert the red / orange external plug and zip the side skin

Plug tethered to left manifold

Figure 3-28 - External Plug for SIM Mode
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4 ASL5000™ LUNG SOLUTION OPERATION FOR SIMBABY™,

SIMMAN® ALS AND NURSING ANNE™

NorTtE

The SimBaby™, SimMan® ALS and Nursing Anne™ have the same general functionality when
connecting to the ASL 5000™ Breathing Simulator. Preparation for the SimMan® ALS was explained in
Section 3 of this manual. The details below will identify the differences between each manikin setup.

4.1 Preparing SimBaby™ for use with the ASL 5000™

4.1.1

SimBaby™ with ASL 5000™ Operation

On the SimBaby™ right side (from the perspective of the baby), separate the skin where the
Ethernet adapter is located
Remove the rubber plug — DO NOT DISCARD

Remove
rubber plug

Figure 4-1 - Plug for Operation without ASL 5000™

Insert the 15mm elbow connector from the Lung Adapter kit into the side port of the SimBaby™

Figure 4-2 - Lung Adapter with SimBaby™

Insert the 22mm connector into the ASL 5000™ port

Figure 4-3 — SimBaby™ Connected to ASL 5000™
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4.1.2 SimBaby™ without ASL 5000™ Operation

e Remove the 15mm elbow connector from the side port of the SimBaby™

Figure 4-4 - Remove 15mm Adapter

e Insert rubber plug into side port of SimBaby™

Figure 4-5 - Insert Rubber Plug '

4.2 Preparing Nursing Anne™ for use with the ASL 5000™

e Nursing Anne™ has a 15mm connector protruding from the hip of the manikin. Connect this to
a 22mm tube to the ASL 5000.

Figure 4-6 — Connecting Nursihg Anne™ to the ASL 5000™
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4.3 Network Configuration for SimBaby™ / SimMan® ALS / Nursing
Anne™

B’ Norte

For use with SimBaby™ / SimMan® ALS / Nursing Anne™, LLEAP version 6.7 and associated firmware or
later must be installed as well as the latest ASL 5000™ LLEAP plugin prior to configuring the connection.

SimBaby™ / SimMan® ALS / Nursing Anne™ do not have an internal router that can be placed in AP or
Client mode. The manikins can operate wirelessly or can be connected directly to a network via an
Ethernet cable.

If using an external router, IngMar Medical, LLC recommends the following minimum specifications:
e Support 802.11n minimum, 802.11ac preferred
e Atleast 2 ethernet ports (not including uplink port)
e Region-specific power adapter

37
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4.3.1 Connecting SimBaby™ / SimMan® ALS / Nursing Anne™ Using the ASL 5000™
Serial Number

1. Connect wirelessly or use an Ethernet cable from the Ethernet port on the right side of the
SimBaby™ / SimMan® ALS / Nursing Anne™ to one of the following options
a. Numbered port on an external router
b. Network (via wall jack or switch)
2. Connect an Ethernet cable from the ASL 5000™ to the same option as listed above

B NortEe

Configure the SimBaby™ / SimMan® ALS / Nursing Anne™ to the same network as the ASL 5000™ using
the LLEAP “Simulator Firmware & Network Wizard”

Patient
=

To router or wall jack

Ethernet EDE USB lf _/ Respi-

Wireless connection OR
to router or wall jack

To ASL 5000™ /
To manikin

To ASL 5000™ /
To manikin

Figure 4-7 - Ethernet Cabling

w

Turn on the SimBaby™ / SimMan® ALS / Nursing Anne™ and the ASL 5000™
4. AFTER the red light on the front of the ASL 5000™ is OFF (~30 seconds), start the LLEAP
software
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’ MR
— - e
— [ 8 husom

CAUTIONL p\(',\'\\l e SQ(\I Q \_\“\%
Wait for red light to turn
OFF for system ready

ASL power switch
(rear of system)

Figure 4-8 - ASL Power and Ready State

5. From the View menu, open the IngMarDefault layout to view the six (6) ASL windows
6. Locate the ASL Session Control tab which will share the window with LLEAP’s Session Control

[0 PAUSE - Healthy patient - Virtual SimMan 3G - Manual Mode - LLEAP
File Tools SimStore Help

e Scenario Language 0 Body 50
Show Disabled Messages Heart:

I Full Screen mo | L Lung
Windows v ALung
Arrange Windows =] Sowel

Save Layout as..

Load Layout

Korotke

Save theme... | | Save current state to theme.

[

-¢- INGMaAR MEDICAL

Pati g g e Earton e

e oQoe

Figure 4-9 - IngMarDefault Layout
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7. Configure the ASL 5000™ connection Settings in the ASL Session Control window

40

Click Configure

Configure

Connect

> II . 630 ASL Status: Unconnected

Device: Standalone

ASL 5000 Configuration

Click Connection Settings

Manikin Attached

Shivw Tatal Violume

Done

Please select the connection type:

Click Ethernet

8. Click Device ID:

Click Okay
-
el ,/

Figure 4-10 - Configuring Ethernet Connection

9. Type the ASL 5000™ serial number into the Device ID: field
10. Ignore the IP: field and the Static IP button

11. Click Done

Configure Connection

Type ASL serial number
(found on rear of ASL)

=
fy DevicelD 1234
Do Not U
& Network Address: o Not Use
Static IP
Click Done

Figure 4-11 - Selecting ASL by Serial Number




12. Complete the connection

ASLSession Control || Sesslon Control

SR
- Op
Configure Ll LN
Connect
——
)
. =0
Disconnect
——
)
) 22
Configure lLg | I I NG
Disconnect
—

Press Connect to

establish connection

ASL Status:

Device:

ASL Status:

Device:

ASL Status:

Device:

Unconnected
1821

Unconnected

Connecting
1821

Connected
1821

Figure 4-12 - Connecting to ASL by Serial Number

Connecting

Connected

13. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization
14. On the “ASL Session Control” or LLEAP “Session Control” windows, click the ® button to start a

simulation
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4.3.2 Connecting SimBaby™ / SimMan® ALS / Nursing Anne™ where the ASL 5000™
requires a unique IP address

1. Connect wirelessly or use an Ethernet cable from the Ethernet port on the right side of the
SimBaby™ / SimMan® ALS / Nursing Anne™ to one of the following options
a. Numbered port on an external router
b. Network (via wall jack, for example)
2. Connect an Ethernet cable from the ASL 5000™ to the same option as listed above

B NortEe

Configure the SimBaby™ / Nursing Anne™ to the same network as the ASL 5000™ using the LLEAP
“Simulator Firmware & Network Wizard”

Ethernet EPE USB J{' _/ Respi-

Patient

Wireless connection or To router or wall jack
To router or wall jack

To ASL 5000™
/ To SimBaby™

To ASL 5000™ /
To SimBaby™

Figure 4-13 - Ethernet Cabling

3.

Turn on the SimBaby™ / SimMan® ALS / Nursing Anne™ and the ASL 5000™
4. AFTER the red light on the front of the ASL 5000™ is OFF (~30 seconds), open the LLEAP
software
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ASL power switch
(rear of system)

5. From the View menu,

6. Locate the ASL Sessio

<¢' ING]

Long Medet

MAR MEDICAL

‘ e \?ﬂ’g‘b_l\\,\m AL

8 ALz

—
p—
—
— R
Active Servo \Lang

CAUTIONY

Wait for red light to turn
OFF for system ready

Figure 4-14 - ASL Power and Ready State

open the IngMarDefault layout to view the six (6) ASL windows
n Control tab which will share the window with LLEAP’s Session Control

[0 PAUSE - Healthy patient - Virtual SimMan 3G - Manual Mode - LLEAP
File Tools SimStore Help

" Scenario Language v Body s0
e
Show Disabled Messages Heart:
Full Screen F11 L Lung
Windows » RLung

Arange Windows

Save Layout as..

Load Layout

Korotke

Save current state to theme, o

Custom Medets

A

Normal

000 ®

Figure 4-15 - IngMarDefault Layout
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7. Configure the ASL 5000™ connection Settings in the ASL Session Control window

44

Click Configure

Configure

&

Connect

ASL Status:
Device:

> nnn

Unconnected
Standalone

Click Connection Settings

ASL 5000 Configuration

Manikin Attached

Shivw Tatal Violume

Done

Click Ethernet

Cancel

Please select the connection type:

Click Okay

Figure 4-16 - Configuring Ethernet Connection

8. Click Network Address

9. Type the IP address provided by the customer into the Network Address: field
10. Ignore the Device ID: field and the Static IP button

11. Click Done

Type IP address

X — e e L el

Configure Connection

Do Not Use

1=

Device ID:

192.168.168.112]

Cancel

Click Done

Figure 4-17 - Selecting ASL by IP Address



12. Complete the connection

ASL Session Control || Sesslon Control

ASL Session Control || Sesslon Control

&5L Session Control || Session Contral

O,’)

Connect

&2

Disconnect

&2

Disconnect

Press Connect to
establish connection

ASL Status;, Unconnected
Device: 192.168.168.112

Unconnected

ASL Statu Connecting
Device: 192.168.168.112

Connecting

ASL Statug: Connected
Device: 192.168.168.112

Connected

Figure 4-18 - Connecting to ASL by IP Address

13. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization
14. On the “ASL Session Control” or LLEAP “Session Control” windows, click the ® button to start a

simulation
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4.3.3 Connection using SimBaby™ / SimMan® ALS / Nursing Anne™ as Virtual
Simulator (Local Computer) with a Physical ASL 5000™ Breathing Simulator

B NoTtEe

LLEAP can control the ASL 5000™ while running as a Virtual Simulator. The ASL 5000™ must have an IP
address provided by any of the methods defined above. The computer running the LLEAP software
MUST be connected to the same network as the ASL 5000™ (same IP subnet)

1. Connect an Ethernet cable from ASL 5000™ to a numbered port on an external router
OR

2. Connect an Ethernet cable from ASL 5000™ to a network (via wall jack, for example)

3. Turn on the ASL 5000™

4. AFTER the red light on the front of the ASL 5000™ is OFF (~30 seconds), open the LLEAP
software

5. When the LLEAP Select Simulator window opens, in the Virtual Simulator window, select Local
computer

LLEAP -

Select Simulator

Network Status \ Virte=! Zhuator

LAN: connected Local computer
WiFi: not available ‘ P n ’
Mot started yet

Hosted: not available

Select Local computer

Patient Simulator

Searching...

Task Trainer
Mot started yet

|~ |
Standardized Patient H

Mot started yet

Advanced options

Figure 4-19 - LLEAP Select Simulator Window
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6. Select the SimBaby™, SimMan® ALS or Nursing Anne™ option as it is the only compatible
manikin

Select Virtual Simulator

SimMan ALS “; MNursing Anne Simulator e
SimMan 3G =S SimBaby Classic =
SimMan Essential —_m SimMan 3G Mystic -‘t'
SimBaby *r = SimMan Classic .
SimMan 3G Trauma . 3 SimMom o
SimMan Essential Bleeding —% SimNewB o

Figure 4-20 - Select Option

7. From the View menu, open the IngMarDefault layout to view the six (6) ASL windows
8. Locate the ASL Session Control tab which will share the window with LLEAP’s Session Control

[0 PAUSE - Healthy patient - Virtual SimMan 36 - Manual Mode - LLEAP
File Tools SimStore  Help

Scenaric Language » Body so
The'

' Show Disabled Messages

s are set to normal

Full Screen F11
Windows v
Amange Windows

Save Layout as.

Load Layout

Korotke

-¢- IncMar MEDICAL

- [ Al
ormal s Wy i ST ———
f / e — : [ |

| configur [T Coo®

Figure 4-21 - IngMarDefault Layout
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9. Configure the ASL 5000™ connection Settings in the ASL Session Control window in any of the
configurations from the options above

10. Make sure the “Manikin Attached” toggle is in the OFF position (not green) as shown in the
image below

O o e

ASL 5000 Configuration

Volume Conversion

Connection Settings )
g Settings

Manikin Attached

{ |
pS A
|'f H\I
\ S

Show Total Volume

Figure 4-22 — Manikin Compensation Toggle

11. The ASL 5000™, when connected, makes an audible “wiggle” as part of its initialization

12. On the “ASL Session Control” or LLEAP “Session Control” windows, click the ® button to start a
simulation



5 UsING THE ASL 5000™ WINDOWS IN LLEAP

5.1 The LLEAP Environment with ASL 5000™ Windows

With the Lung Adapter installed, the LLEAP interface now has the enhanced respiratory features of the
ASL 5000™ Breathing Simulator. Get started by loading the LLEAP software with the additional ASL
5000™ windows. As stated above in the Overview (Section 2.1), each ASL 5000™ window is accessible
via the View Menu option. The instructor can place the ASL 5000™ windows into convenient positions
within the LLEAP view. IngMar Medical has created respiratory-centered views for some of the themes
defined in the LLEAP Select Theme window. The following figures display the LLEAP default themes
and an example of a respiratory-centered theme:

I PAUSE - Heslthy patient - Virtusl SimMan 3G - Manual Mode - LLEAP 8 %
File View Tools SimStore Help
Bady Vor
hy patient ¥ -
Heart | Nomnal v ¢
Liung:  Momal v 8 i
Rlung:  Momel
N . 98
Mare bedy saunds... Auscultation foc .
Sereamning (tvpe 2 ¥
Karotiaff wolum (] fuscultstion gap © & .
e — R © o oia. 25112
Mare sounds. 0. (1 s)
save theme...| | Sane current state to theme... | oz oo Bt
A——:\ -
F {3 Wi atDg

\

=
—
e J
Q m.'_\."'__;
AR
| —

=,

\ Stamach distention
| || Eshale CO:
| / JII ] Tangue faback
L .

Wide open ¢~ Momal i
Circulation & Fiuids | CPR. || CPR Histary
|.a \.|§ & Mormal -
Corulsions: OFf

jsege Upp pet i v

Fules: pper port | Arterin) o | Simulstor | Locsl BC Stabus
e — 0 % [ABd Comment...
I I Lawer port Arterial - sion started: Healthy patient
00 State entered: All normal

B R L, L | — %
Secretions:
] Sweat ] Eyes Mouth Urine
[ Ears | Mose i Froth Off

0:00Q @ O ® O PAUSE 000 @

Figure 5-1 - LLEAP Healthy Patient Theme
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I3 Heslthy petient - Virtual Simian 3G - Manual Made - LLEAF
File View Tools SimStore Help

A5L Quick Choice Menu | ASL Lung Model Control || ASL Breath Effort Control

-¢» INGMAR MEDICAL

Lung Madel:

Pstient Monitor | Eyes

Patient Type: Custom Madels

[=1T0 0 List

Mormal 45L Maonitor | ASLEquation of Motion | Theme Control | CPR | CPR History

[ eooh |
At T T T TT
) I I
|
N | U 4
Apnea
- — —J - — —
o 15 2
ASL Sesslon Contral || Session Control
ASL Status: Samulating
onfigure gl DRI G (it

B
x

Aiw. Pred.. | Trends  Card.. | Com.. | Lear.
Fresel: Mormal ~

Istance % Compliance ©
AE- 0 - 100

=33 —&

—5T= -n
| oo -0
7 stomach distertian

Exhale COy

7 Tongue fallback

cire... || Sou.. | Sess.. | Sm. || tew.. || con.

Freeze Convulsions: | Off

Pubas: [ Upperpert | Arterial

LT =
[ Lewer pert | Artesial

B T 0%

Secretions:

[ Sweat [ Eyes [ Meath Urine

[Jears  [Mose [Froth  Off

000 &

Figure 5-2 - Respiratory-centered Healthy Patient Theme

ﬂ PAUSE - Asthma - Virtwsal 3imPdan 33 - Manual Mode - LLEAP
File View Tools SimStore Help

_ = —

(4}

standards of | vial signs Breathing Physician

N
| @&

—_—
on
‘Wash hands Calming patient
Identify patient Calming family member Wide open 'Q‘ Marmal
El L] Normal
Introduce self
Pr Nomal ~
Calm the patient Resistance % Compliane %
FCe- 0 -l Ee—100
= -
- -
| -1 -o Pradition
[ Stomach distertion
Exhate (O
Tongue fallback
Theme | Asthma -
Circulation & Fluids PR CPR History Ongoing care
Convulsiens: | OFf
Pukes: [7] Upperpert | Artesial
u L “ h ———————— 0% | Ba
i [] Lower port | Artesial ]| | G
00
R R (N — D
Secratians:
Sweat Eyes [ Mowth Urine
Fars Mose A Froth [

Figure 5-3 — LLEAP Asthma Patient Theme
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Session Log

Trends  Cardia¢  Comments | Learner Patient Monitor Buttons

Simulstor  Locsl PC Status | Connections Status

View [asd Comment...

Session started: Asthma
Slate entered: Mild asthma

000 ®



n Asthma - Virtual SimMan 3G - Manual Mode - LLEAP - bt
File View Tools SimStore Help

0:50 M“d asthma ASL Quick Ch... L ASL Monitor L ASL Equation. ASL Breath Eff. ASL Lung Mo... ,
. -é- INGMAR MEDICAL
(7] oy ] [ 4l
&

of Patient Type: Lung Model: Custom Models

Standards of Vital signs Breathing Physician
care

Correct treatment Communication
Wash hands Calming patient “ “ ﬁ
. . . . Normal ARDS
Identify patient Calming family member 0 i Asthma

Direct communication with

Introduce self N phvsician * || =
\M_"/ Apnea _7
Theme: | Asthma v Select the severity of the disease state:

Prediction | Trends  Cardiac  Comments  Learner Patient Monitor Buttons

(3 Mild asthma

i ‘ . ‘
™ Moderste Severe

L oL 3
SALBUTAMOL Airway.. | Circulati.,  Eyes | Sounds  CPR  CPRHis..  Ongain..

Rig
Healthy = — ke Preset: | Custom

Resistance%  Compliance % Session Log | Simulator | Local PC Status || Connections Status
° —;gn Basic View Add Comment...
) | ACTIVATE v/ . i 0:00 Session started: Asthma
=100— -0 000 State entered: Mild asthma

Save theme... | [ Save current state to theme... |

Stomach distention
Session Contrel || ASLSession Control [[] Exhale cO:

[] Tongue fallback

ASL Status: Simulating
Device: Standslone

000 @

Figure 5-4 — Asthma Theme with IngMarUnhealthy Layout

B Norte

Please refer to the LLEAP tutorials for information about working with windows and themes.
Details can be found at www.laerdal.com

5.2 ASL Session Control

5.2.1 Connect / Control buttons

ASL Session Control Session Control

e 0 6
Configure Ll [l

ASL Status: Connected
Device: 1821

Disconnect

Figure 5-5 - ASL Session Control

The ASL Session Control window includes control of the ASL 5000™ and simulation session.

1. The > (Play) button mimics the function of the same button in the LLEAP Session Control

2. The il (Pause) button mimics the function of the same button in the LLEAP Session
Control. It also sets the ASL 5000™ breath effort to zero (a passive lung) to avoid any
ventilator alarms.
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3. The n (Stop) button ONLY stops the ASL 5000™ lung. The other components of the LLEAP
simulation is unaffected.

S0

4. The ¢~ (Connect / Disconnect) button connects to an instance of the ASL 5000™
(Standalone, ASL with s/n, or ASL with IP address)

5. The Status and Device monitors provide connection feedback to the user

5.2.2 Configure Button

Clicking the Configure button opens the ASL Configurator window. This window is used to set the
connection type and the volume conversions to be used.

InGMaR MEDICAL ASL Configurator

ASL 5000 Configuration

Volume Conversion

Connection Settings

Settings
Manikin Attached L )
Show Total Volume ':\ ,:'

Figure 5-6 - Configuration Tool

The simulation environment can be informed if a SimMan®, SimBaby™, or Nursing Anne™ is connected
using the “Manikin Attached” toggle switch. When ON (green), the software will compensate for the
additional tubing between the ASL 5000™ and the mouth of the manikin. If the simulation does not
require a manikin as in sections 3.2.2.4 and 4.2.3 above, the “Manikin Attached” toggle should be se to
OFF (not green) and a ventilator (for example) can be connected directly to the ASL 5000™.

The “Show Total Volume” toggle represents different way to view the waveforms provided by the ASL
5000 lung. The default is for the toggle to be set to the OFF position. When the toggle is OFF, the
waveforms represent feedback similar to how a ventilator displays information. The volume waveform
displays a single waveform representing the Tidal Volume (Vt). The pressure waveform is represented
by two graphs (if applicable). One is the airway pressure and the other is the muscle pressure. The
flow waveform is a representation of the total flow into and out of the lung.
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ASL Monitor  ASL Equation of Motion ~ Theme Control ~ CPR CPR History

S 6 FIP [cmH20]
T
Airway Pressure — = 2
Muscle Pressure — & PPLAT [emH20]
g -6 0
@
a -104
30! PEEF [emH20]
109/ | 0
Flow — Rate [bpm]

Flow [L/min]
W -
Qo o
__,_‘_\

w1
o

Tidal Volume [mL]
|
= 1 |

Tidal Valuma — %200' |l." \ll | /' ||| [ MV [Lfmin]
3™/ \_ \ ./ 5.13
g |
01 § . | .
0 5 10 15 20

Time [s]

5-7 - Total Volume Toggle OFF - Showing Tidal Volume

When the toggle is ON, the waveforms change to be representative of the various compartments of
the lung. This includes Total Volume (including volumes related to air-trapping) as well as left and right
lung volumes (if a 2-lung model is being used). The pressure waveforms, in addition to the airway and
muscle pressure graphs, include the left and right lung pressures. The flow waveform is the same
regardless of toggle position.

ASL Monitor ASL Equation of Motion Theme Contral CFR CPR History

Freeze

FIF [cnH20]

"Wﬁﬁﬁﬁﬁ(\m
R

-
L]

7
N
7

Alrway Pressure
Muscle Pressure =
Right Lung Pressure =
Left Lumg Pressure

Pressure [cmH20]
5 o
C T
]
]

'
L

?_Dj PEEP [cmHZ0]
=101 M f M ™ ™ M
NN NN e
Sell || | | |

Flow — —;zl | | | | ‘ |‘ Rarti [hipen]
HUUUUUUWUUL

Tidal Vsbuma [miL]

.].,J\\/\\\f\ f\\/\m
\/\/\/\ —

10 15 20
Time [s]

Total Valime
FRight Lung Volume =
Left Lung Velume

Volume |m||
I’l.l I.u F)
B

-
g

o

w

5-8 - Total Volume Toggle ON
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B Norte

Click

Tidal volume is represented by the change in volume that is not affected by PEEP or air-trapping
within the lung. Thus, Tidal Volume always returns to zero on the y-axis. Total volume is a
more detailed representation of what is actually happening in the lung. Total volume includes
the offset due to PEEP or air-trapping.

Volume Conversion

Settings

to adjust volumes based on the volume/gas correction factors planned for the

upcoming simulation.

% INnGMAR MEDICAL ASL Configurator

Volume Conversion Settings

Conditions: | BTPS ~

BTPS
STPD
SPD (T=20)
— = comlinces

Figure 5-9 - Volume Conversion Options

The volume conversions are based on the gas correction factors as defined below:

Click

As Measured — Geometrical volume including compressible gas in the lung

ATPD: Ambient temperature (variable) and pressure (variable), dry (no humidity)

BTPS (Default Setting): Body Temperature (37 °C or 310 K) and pressure (generally same as
ambient), saturated (47 mmHg or 6.2 kPa)

STPD: Standard temperature (0 °C or 273 K) and pressure (760 mmHg (101.33 kPa) or 100 kPa
(750.06 mmHg)), dry (no humidity)

SPD (T=20): Standard pressure (760 mmHg (101.33 kPa) or 100 kPa (750.06 mmHg)), dry (no
humidity) at a temperature of 20°C

Connection Settings

to configure the connection type as Stand-alone or Ethernet. When the software

is first installed, the system will be configured with the connection setting set as Stand Alone. This
option is a software-only based simulation with the ASL 5000™ windows. This is similar to using the
Virtual Simulator in the LLEAP environment.
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M

Please select the connection type:

Figure 5-10 - ASL Configurator in Stand Alone Mode

When connecting to the physical ASL 5000™, click the Ethernet egg, then click Okay to open the
Ethernet configuration. Ethernet mode has three (3) options for setup:
e Using the ASL 5000™ 4-digit serial number by clicking Device ID: (recommended)
e Using a defined IP address by clicking Network Address: (IP address set by network)
e Using a static IP address by clicking (manually assigning IP address for ASL
5000™)

Please select the connection type: Configure Connection

Oka
Figure 5-11 - ASL Configurator in Ethernet Mode Figure 5-12 - ASL Configurator Ethernet Options

The Static IP Config option directly assigns an IP address to the ASL 5000™. If this option is used, the
software will search for the first connected ASL 5000™ and set the IP address to the address defined by
the user.

M

Configure Static IP or DHCP

Use static 1P 18

Ketwark Address:
192.168.168.11)

Oka

Figure 5-13 - Static IP Configuration

A

The Static IP option configures the ASL 5000™ with an internal, hardcoded IP address. Only
trained technicians should use this option. Assigning an address that is not compatible with the
network would make the ASL 5000™ unreachable.
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5.2.3 ASL 5000™ Firmware Updates

The ASL 5000™ Breathing Simulator runs on a version of firmware that is verified each time a
connection is made to the LLEAP software. In most cases, the ASL 5000™ has the correct firmware and
the connection to the lung is established. The user may, however, be prompted to update to a newer
version of firmware (internal to the lung simulator) if a new software is released. When clicking the
(Connect/Disconnect) button, the following prompt will open.

K- nomeeoen

The Lung Simulator firmware in your ASL 5000 oppears to be of
o different version than the software on your host computer.

Would you like to upload the new firmware from the host computer?

Figure 5-14 - Firmware Update Prompt

Click Y85 15 allow the upload to take place. This brings up details about the firmware update.

G

KLY UISE THIS DPTION with AS1 serial s greater thon D800 [Babrot CPU)
Consult IngMar Medical and do KOT upgrade if you ave not swre of version rompatibity

DS lung.exa HEV INHE

[mbedied Version = 4.7.76
Tmbedded Version_fime = 5:45 PM
Fmbedded Version_dnte = 72der?14

[DLL REV INFO
Rev 4.7.99 a1 7:30 PW on Hocrdn 1§

Contine with firmware uplead?

- .
Figure 5-15 - Firmware Update Details

Click Yes and the upload process will begin. Once complete, the user will be prompted to restart
the ASL simulator as well as close and restart the LLEAP software.

& o

Firmware uploud was successfull Restart both simulator and LLEAP software.

Figure 5-16 - Firmware Update Complete

A\

Do not turn off the ASL 5000™ Breathing Simulator during a firmware update.
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5.3 ASL QuickChoice Menu

The ASL QuickChoice Menu window provides an array of preconfigured patient types and lung disease
states. The Quick Choice Menu is a great starting point for working with the SimMan® family,
SimBaby™ and Nursing Anne™ with the ASL 5000™ through the LLEAP software interface.

B NoTtEe

The SimBaby™ QuickChoice Menu operates exactly in the same manner as the SimMan® and Nursing
Anne™ QuickChoice Menu.

ASLQuick Cnoice Menu | ASL Lung Madel Control | ASL Breath Effart Cantral |

'é’ INGMAR MEDICAL

Patient Type: Lung Model: Custom Models (\

™

Normal

(2)

$

u Apply

Apnea

Figure 5-17 - ASL QuickChoice Menu

1. Select a Patient Type and Lung Model by clicking the appropriate “eggs,” then clicking

Apply

2. The selected Lung Model will be highlighted in green
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A5L Quick Choice Menu || ASL Lung Model Control | | ASL Breath Effort Control |

‘é’ INGMAR MEDICAL

Patient Type: Lung Model: Custom Madels

Adult Save Current Model Apply

Apnea O

Select the severity of the disease state:

| Mild e Moderate Severe |

Figure 5-18 - ASL QuickChoice Menu
3. When selecting a disease other than Normal, the user can adjust the severity of the disease

4. At any time during the simulation, the patient can be set to become completely passive by
clicking the Apnea switch
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Table 1 - Patient Model Definitions

The table below displays the lung settings for all the patient models in the Quick Choice library:

Adult Normal
Compliance | Resistance | Patient Rate | Effort Rise % Release %
Healthy 50 13 15 10 25% 10%
Adult Asthma
Compliance | Insp/Exp Patient Rate | Effort Rise % Release %
Resistance
Mild 80 35/55 20 15 20% 15%
Moderate | 40 45/95 30 15 35% 20%
Severe 35 55/125 35 30 20% 20%
Adult ARDS
Compliance | Resistance | Patient Rate | Effort Rise % Release %
Mild 40 21 25 7 35% 10%
Moderate | 25 35 30 10 40 20%
Severe 10 40 40 20 30 10
Adult COPD
Compliance | Insp/Exp Patient Rate | Effort Rise % Release %
Resistance
Mild 50 17/20 12 20% 15%
Moderate |53 26/28 22 35% 30%
Severe 53 26/28 30 35% 42%
Adult ILD
Compliance | Insp/Exp Patient Rate | Effort Rise % Release %
Resistance
Severe 18 40 27 10 18 10
Baby Normal
Compliance | Resistance | Patient Rate | Effort Rise % Release %
Healthy 6 86 28 10 20% 10%
Baby RSV
Compliance | Insp/Exp Patient Rate | Effort Rise % Release %
Resistance
Mild 40/60 45 6 30% 10%
Moderate | 4 65/85 50 35% 10%
Severe 80/100 60 14 40% 10%
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Baby BPD

Compliance | Resistance | Patient Rate | Effort Rise % Release %
Mild 4 60/120 55 15 32% 10%
Moderate |3 80/150 60 15 32% 10%
Severe 2 120/180 65 15 32% 10%

In any given simulation, the instructor may believe that the lung diseases provided by the software do
not fully represent the teaching goals. For example, an asthmatic patient model should have a much
higher inspiratory resistance than what the QuickChoice model provides (see Severe Adult Asthma in
the table above). The user can make changes directly to the Lung Model and Breath Effort windows
and see the resulting waveforms in the ASL Monitor window. Once a satisfactory response is created,

the user can click the e button. This will prompt the user for a custom model

name.

Once saved, view all custom patient models by clicking the Custom Models toggle switch. This gives
the instructor a listing of all custom patient models that have been created. Use the search function to

Cancel

Save Custom Lung Model

Patient Type: Adult

Model Name: ‘Asthma1

Save

Figure 5-19 - Save Custom Model Prompt

quickly find your custom patient models.
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ASL Quick Chaice Menu || ASL Lung Model Control | ASL Breath Effort Control

‘é’ INGMAR MEDICAL

™
Patient Type: Lung Model: Custom Models (
= [ impor | Expor_|

Double click to apply...
T

- Apoly

Apnea

Figure 5-20 - Custom Disease States

Delete any unwanted custom disease states by clicking the file name and pressing the delete key on a
keyboard. This will open prompt confirming the deletion.

- o e

Do you really want to delefe Asthmal?

Figure 5-21 - Deleting Custom Disease State

The QuickChoice window gives the user the ability to import and export custom lung models.
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Exporting a model:

After a model is created and saved as a custom model, click the button from the Custom
Model window. This opens the Export Custom Lung Models window.

[ Export Custom Lung Models *®

Available Models: Models to Export:

|

fsthmal

Export Models

Figure 5-22 - Export Custom Models

Click the model to export from the Available Models. Clicking the right-facing arrow will shift the
selected models to the Models to Export field. More than one model can be exported at a time. When
the models are ready to export, click the button which will open a navigation
window with the default MyPatientModels.pat filename and format.

1 savens X
« v 4 @ mbails > Laerdal Simulation v &/ | Search Laerdal Simulation »
Organize *  New folder =

1 This pC A Name Date modified Type Size
J 3D Objects Client File folder
I Deskiop Otherfiles File folder
) Documents Patients File folder
Resources File folder
4 Downloads
Saved Sessions File folder
B Moves Scenarios File folder
b Music Server File folder
(=] Pictures Simtore Scenarios File folder
‘i, Local Disk (C) Themes File folder
@ DVD Drive (D P
L . _ R @ bd
File name: | MyPatientModels.pat -
Save astype: | PAT Files (*pat) -
 ideFldes Conc

Figure 5-23 - Exporting Lung Models

Clicking the Save button will confirm the export is complete with the following message:

Export Complete *

1 model(s) have been saved to MyPatientModels.pat.

Figure 5-24 - Export Confirmed
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Importing a Model:

The process for importing a lung model is similar to exporting. Click the BT button which opens

a navigation window. Browse and select the [filename].pat and click Open.

Kl open x
A @ s mbails > Laerdal Simulation v | | search Laerdal Simulation 2
Organize = New folder =+ M @
A Name Date modified Type Size
s Quickaccess
Client File folder
AL Software
Otherfiles File folder
ASL Software Paticnts File folder
ASL Software Resources File folder
main Saved Sessions File folder
ASL Test Autc Scenarios File folder
A5Ldats Server File folder
Ecitable LS Man SimStore Scenarios File folder
Themes File folder
Editable LS Mani
[ ] MyPatientModels.pat PAT File
LungSalutionS
& OneDrive
ol Date modified 5
Famms | - ‘ PAT Files (*.pat) v

Figure 5-25 — Importing Lung Models

The Import Custom Lung Models window opens.

[ imoort Custom Lung heodels *

Available Models: Models to Import:

|
fsthmal

-

Import Models

Figurré775-26 - Import Custom Models
Click the model to import from the Available Models. Clicking the right-facing arrow will shift the

selected models to the Models to Import. More than one model can be imported at a time. Clicking
the button will confirm the import is complete with the following message:

Import Complete x

1 model(s) have been imported,

Figure 5-27 - Import Confirmed
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5.4 ASL Monitor

The ASL Monitor window includes two views for the instructor, the Monitor view and the Equation of

Motion view.

The Monitor view is a useful tool for analyzing the waveforms and readings directly from the lung.
These include pressure (cmH20), flow (L/min) and volume (mL) waveforms. Relevant lung parameters
are also monitored and are updated upon the completion of a patient breath. Set the view (Tidal or

Total volume) from the button in the “ASL Session Control” window.

ASL Monitor  ASL Equation of Motion ~ Theme Control ~ CPR CPR History

g 6
0 0
Mirway Pressure — S 2]
Muscle Pressure — & °°)
2 -6
g )
a -104
30
T 1/ /M N\ \ M
£ 10'.{\'1 [ / \ Ip". /
E " PR S R — — —
Flow— =-10 I| f7 0 |/ | .f/ | .-/ I| f;/
830 |f \/ \/ \/ "
e 1 LII |.I| | |' |II
50 ¥ ¥ ¥ ¥
—annl \ f 1
7300 /| N I\ / .-"ﬂl'l
= 1 f1 [ 1 |
" { | [ [ [ /
TidalVoluma — £ 2007 [ | |1 [ (. [
idal Volume E 100 / |II o [\ / |II /I III / |II
5 [\ [\ \ /
Y AN S —/ \
0 5 10 15
Time [s]

5-28 - Toggle OFF showing Tidal Volume

Flow is the total flow in the system

PwnNPE

purposes

e Freeze

FIP [cmH20]

PPLAT [emH20]

PEEP [cmH20] o

Rate [bpm]

y

Tidal Volume [mL]

MV [Lfmin]

Pressure waveforms include airway (external) and muscle (spontaneous breathing)

Volume waveforms are based on Tidal Volume and always return to a zero baseline
At any time during the simulation, click Freeze to freeze the waveform view for debriefing

5. Seven (7) breath parameters provide lung details that may be essential to a simulation.
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A5L Monftor | ASLEquation of Motion ~ Theme Control = CPR CFR History

10/ o | PIP [emH20]

e B e T e s B i Bl B

Airway Pressurg =
Muscle Pressure —

Pressure [cmH20]
o

Right Lung Pressure — _51 d d d U u g u PPLAT [emH20]
Left Lung Preasure
-101
-15]
_ 20/ PEEP lemH20]
Eisi |\ \ A\ \ N
Flow Elg e | || |] | ‘ ‘ | ‘ ‘ ‘ W P e
- U G s
Tidal Volume [mL]
135.44
Total Volume — — 200

MV [L/min]

'

Right Lung Volume =
Laft Lung Voluma

Time [s]

Figure 5-29 - ASL Monitor View

Pressure waveforms include airway (external), muscle (spontaneous breathing), as well as
left and right internal lung pressures

Flow is the total flow in the system

Volume waveforms include total, right, and left lung volumes as well as a representation of
air trapping (or breath-stacking) due to PEEP or lung mechanics (resistance or compliance)
At any time during the simulation, click Freeze to freeze the waveform view for debriefing
purposes

Seven (7) breath parameters provide lung details that may be essential to a simulation. The
Tidal Volume calculation is based on the maximum volume over baseline (e.g. volume due
to the presence of PEEP)
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5.5 ASL Equation of Motion

The Equation of Motion (EOM) window gives the user a different way to look at the patient breathing.
This is a real-time analysis of the mechanics of breathing represented by the components of the EOM.

66

o Pmus + Paw = + Flow - R

11
g
[ 9
E 7
£ 0
+ 3
z 1
g

-1

o 5 10 15 20

Time [s]

Vol/C + Flow x R
® b O b @

,waf%/_fvﬁﬁfﬁ/

5

o

Time [s]

Figure 5-30 - Equation of Motion Window

1. Definition of the Equation of Motion where Pmus is the patient’s spontaneous muscle pressure
in cmH20, Paw is external pressure sensed by the ASL 5000™ in cmH20. Volume isin mL, Cis
lung compliance in mL/cmH20, Flow is in L/min and R is airway resistance in cmH20/L/s

2. The left side of the equation is shown in the top graph

The right side of the equation is shown in the bottom graph

4. Click the Freeze button to freeze the waveform view for debriefing purposes

w

B Mot | %0 bquatien < Wabizn | Theme Conteel || || DR Pubery.

Pmus + Paw [cmH20]
T B

o
=)
HEY]
7

w

F Y

Vol/C + Flow x R
RN

[} 1 2 3 4
Time [s]

Figure 5-31 - Equation of Motion Last Breath
5. Switch between the real-time view and a snapshot of the last recorded breath

6. Follow the changes in a single breath for better understanding of how pressures, flows and
volumes relate to the patient’s lung conditions (Resistance and Compliance)



5.6 ASL Lung Model Control

The ASL Lung Model Control window provides direct control of the patient’s lung and airway
mechanics related to resistance and compliance. This includes single or dual lung models and
inspiratory versus expiratory resistance.

ASL Quick Choice Menu | | ASL Lung Madel Control | | ASL Breath Effort Control | ASL Quick Choice Menu | ASL Lung Madel Control | | ASL Breath Effart Control
Breaths Per Change: n Advanced | } Breaths Per Change: n Advanced |

e e Compartment Settings | Resistance | Compliance

Resistance (cmH20/L/s) Compliance (mL/cmH20Q)

Two-Compartment
Model:
! 225
175 e S
250 _ /
150 Separate Insp/Exp
L o Resistance:

125 e —
25 : :

100

Figure 5-32 - Lung Model Control

1. Resistance knob: the user can also double click the number inside and directly type a value.
a. SimMan® / Nursing Anne™ total resistance range is from 8 — 157 cmH20/L/s
b. SimBaby™ total resistance range is from 23 — 250 cmH20/L/s
2. Compliance knob: the user can also double click the number inside and directly type a
value.
a. SimMan® / Nursing Anne™ total compliance range is from 0.5 — 250 mL/cmH20
b. SimBaby™ total compliance range is from 0.5 — 15 mL/cmH20
3. Breaths per Change slider is used to adjust the number of breaths used to transition from
an existing value to the new set value (e.g. Set compliance from 50 to 10 with 5 Breaths per
Change, it will gradually reduce its value)
4. Switch to the Advanced view for greater control of the lung characteristics. The figures
below provide the different control options for the lung models
5. Switch defining One or Two compartment lung models
6. Switch defining Resistance where inspiratory and expiratory resistances are equal or
unequal (e.g. Asthmatic patients typically have unequal inspiratory and expiratory
resistances Rin # Rout)
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5.6.1 Advanced - Single Compartment Lung Model

454 Quick Chaice Menu || At Lung Madel Contro! || 451 Breath Effos Control | T ASUGulck Chalce Meni | ASL Lung Model Contral || ASLBreath fort Contral | A Guie choice Mend || AsL Lung Model Contral | ASLBreath efort Contial |
Breaths Per Change: n: Advanced (| Breaths Per Change: n Advanced () Breaths Per Change: n Advanced [
Camrmen s Bmitre | Comprre| ] i ] o |
Resistance Compliance
(cmH,0/L/s) (mL/cmH,0)
120 200

135 225

Two-Compartment

Mode: \ 150 250

O 90 150
Separate Insp/Exp
Resistance: 0 0
= 75 125
15 25
s 20 75 0
Figure 5-33 - Lung Model — Simplified Lung Model 1 Compartment with Equal Resistances
5.6.2 Advanced — Two Compartment Lung Model, Equal Resistance (Rin = Rout)
ASLQuick Chaice Meny | ASL Lung Madel Control | | ASL Breath Effart Contral | A5L Quick Choice Menu | | ASL Lung Model Control | | ASL Breath Effort Control | ASL Quick Choice Menu || 5L Lung Model Control || ASL Breath Effort Cantrol
Breaths Per Change: | Advanced 77 Breaths Per Change: Advanced () Breaths Per Change: Advanced (T )
Compariment Settirgs | Resistance | Compliance | || | compartment settings | Resistance | Compliance | e Setings | Resistance | Compliance |
C Right C Left
Two-Compartment Trachea Right Left (mL/cmH;0) (mL/cmH,0)
Model: (cmH;0/L/s) (cmH,0/L/s) (emH,O/L/s) 200 50 00 s
=~ 120 435 20 435 120 q35 175 - 175 -
1; 105 1 105 1o 105 o 250 250
Separate Insp/Exp ® B 150 150
Resistance: . [ o . ° ° 0 0
— N i A g 15 125 125
- 4 s 30 P a5 25 25
100 100
75 0 75 0

Figure 5-34 - Lung Model - 2 Compartment with Equal Resistances
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5.6.3 Advanced - Single Compartment Lung Model, Unequal Resistance (Rin # Rout)

ASL Quick Chobce Menu L ASL Lung Model Control U ASL Breath Effort Control L

Breaths Per Change: II

Companiment Settings | Resistance | Complisnce

Two-Compartment
Model:

L

Separate Insp/Exp
Resistance:

@

Advanced (1

Breaths Per Change:

Compartment Settings | Resistance | Compliance |
Resistance
(cmH;0/L/s)

120

Advanced E}

135

Inspiratory

Expiratory

Breaths Per Change:

Compartment Settings ! Resistance  Compliance

| ASLQuick Choice Menu || ASL Lung Model Control || ASL Breath Effort Control ASL Quick Choice Menu L ASLLung Model Control || ASLBreath Effort Control |

Advanced

Compliance
(mL/cmH,0)

200

225

Figure 5-35 - Lung Model - 1 Compartment with Resistance_in not equal to Resistance_out

5.6.4 Advanced — Two Compartment Lung Model, Unequal Resistance (Rin # Rout)

ASL Quitk Choice Menu | ASL Lung Model Control | ASL Breath Effort Control

Breaths Per Change:

Compartment Settings | Resistance | Compiance |

Two-Compartment
Model:
— "':
Separate Insp/Exp
Resistance:

-

Advanced (7

ASL Quick Choice Menu | | ASLLung Model Control | | ASL Breath Effort Contral |

ASL Quick Choice Menu I ‘ ASLLung Model Control | ASL Breath Effort Control

Breaths Per Change: Advanced (17 ) Breaths Per Change: Advanced ()
| Compartment Settings | Resistance | compiiance | Compartment Settings | Resistance | Compliance ‘
Trachea Right Left C Right C Left

(emH,0/L/s) (cmH,0/L/s) (cmH,0/L/s)

1

20

135

50

w0

Inspiratory o
i

3

20
1
B!
s ¥ s B
120 55
105
150
]
s
&
n

s
45

Expiratory
™

(mL/cmH,0)

200

225

175 175

250

50

75

(mL/cmH,0)

200

225

250

50

75

Figure 5-36 - Lung Model - 2 Compartment with Resistance_in not equal to Resistance_out
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5.7 ASL Breath Effort Control

The Breath Effort Control window controls spontaneous breathing and breath rate.

ASL Quick Choice Menu ASL Lung Madel Control ASL Breath Effort Control

Breaths Per Change: n Advanced

Muscle Pressure [cmH20] Rate [bpm]
30\ ‘]00 BO‘ ‘JIOO
60 0 60 - 0
40’ 20 40 20

Figure 5-37 - Simple Effort Control

1. Muscle Pressure knob: Patient muscle pressure (negative pressure inside the lungs creating
flow into the mouth). The user can also double-click the number inside and directly type a
value.

a. SimMan® / Nursing Anne™ muscle pressure range is from 0 - 100 cmH20
b. SimBaby™ muscle pressure range is from 0 — 30 cmH20

B’ Norte

A value of zero (0) Muscle Pressure represents a passive, paralyzed or apneic patient. It is also
important to note that this cannot be accomplished by setting the Rate to zero. The ASL 5000™ does
not allow a Rate of zero but does allow a muscle pressure of zero.

2. Rate knob: the user can also double-click the number inside and directly type a value.

Breath rates range from 3 to 100 breaths per minute.
3. Switch to the Advanced view for greater control of the breath effort
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Insp. Muscle Pressure [cmH;0]

Exp. Muscle Pressure [emH;0]

Breaths Per Change: n

| Advanced

Breath Rate 141

e a0 100

Pressure [cmH20]

0 0.5 1 1.5 2
Time [s]

2.5

Insp. Rise Time [%] Insp. Hold Time [%]

8 100

8 100 8 100
e’ﬁ @ n N @ n eﬁ n
a0 2 6 a0 X a0 X

Exp. Rise Time [%] Exp. Hold Time [%]
Ep— B___ Cp—
’ @ e } @ e
40 20 40 20

&0 o

Insp. Release Time [%]

80 100

60 o

e a0 2

Exp. Release Time [%]

a0 100

60 L]

E i )

PwnNPE

b

8.
9.
10. Exp. Release Time (percent of total breath time for release of the positive muscle pressure)

Figure 5-38 - Advanced Breath Effort Control

Breath Rate (breaths per minute)

Pause % (percent of total breath time between insp. vs exp. muscle pressure)

Insp. Muscle Pressure (maximum negative muscle pressure in the lung)

Insp. Rise Time (percent of total breath time for rise to peak negative muscle pressure, similar

to i-time)

Insp. Hold Time (percent of total breath time for holding peak negative muscle pressure)

Insp. Release Time (percent of total breath time for release of the negative muscle pressure,

similar to the passive component of e-time)

Exp. Muscle Pressure (maximum positive pressure in the lung — forced exhalation. Itis
recommended that when setting an Exp. Muscle Pressure, the Insp. Release Time should be set

to zero %)

Exp. Rise Time (percent of total breath for rise to peak positive muscle pressure)
Exp. Hold Time (percent of total breath time for holding peak positive muscle pressure)

11. Graphical representation of spontaneous pressure profile over the defined breath cycle
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6 TROUBLESHOOTING

The following conditions are problems that can be easily identified and remedied by the user.
For any help/support related to the ASL 5000™ please send an e-mail to: support@ingmarmed.com.

6.1 Lung Solution software installer fails

Problem
When installing the Lung Solution software, the installer fails.

Resolution
Make sure LLEAP is installed prior to running the Lung Solution installer. Once this is verified, try to run
the installer again.

6.2 Connecting to ASL 5000™ Simulator

Problem
ASL 5000™ is configured to a serial number or IP address and the Status remains as “Unconnected”

Resolution

Check all connections. Make sure the SimMan® is properly configured in AP or Client mode. Check to
see that the computer running LLEAP is receiving an IP address from SimMan® or the external router
network (for the SimBaby™/ SimMan® ALS / Nursing Anne™ connection). This can be done by opening
the command prompt and typing “ipconfig.” Contact your Laerdal representative if the problem
persists.

6.3 Red LED on the front of the ASL 5000™ remains illuminated

Problem
The red LED on the front of the ASL 5000™ remains on after starting the simulator

Resolution

ASL 5000 Serial Numbers below 2500:

The red LED is a push button switch. If the LED does not turn off after 30 seconds, make sure the LED is
slightly depressed. If the LED is flush with the black housing, the motor inside the unit is disabled.
Once the switch is slightly depressed, cycle the power to the ASL 5000™. If problems persist, please
contact your Laerdal representative.

ASL 5000 Serial Numbers after 2500:

Contact your Laerdal representative.
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